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Intersil Real Time Clock Evaluation Platform

(For use with X1226, X1227, X1228)

AN1138.0Application Note September 24, 2004
A Platform for Assessing the Performance 
of Intersil’s RTC Devices
Intersil manufactures a line of Real Time Clock IC’s that 
integrate multiple features into a single chip. The main 
features include a 32.768kHz oscillator, clock/calendar logic, 
multiple alarms, watchdog timer, power up reset, and 
EEPROM memory up to 256kb. 

The evaluation board provides a platform to test all of these 
functions, as well as evaluate device performance criteria, 
such as long-term clock accuracy. Hardware options such as 
battery and crystal types can also be tested. The software is 
designed to allow easy setup and monitoring of all the major 
device functions. The two-piece construction utilizing a 
motherboard and a daughter card enables the board and 
software to operate the RTC device residing on a remote 
board.

Operation of the Intersil RTC Evaluation 
Board
Hookup and Applying Power
Powering Up - The motherboard should have power 
hooked up to a suitable +5V source through #24 or better 
wires to P2. Make sure the +3.3V/5V jumper (J1) is 
positioned as desired. J1 must have a jumper installed for 
the RTC device to operate. It is also advisable that the 
battery/super cap jumper (J2) be removed before initial 
power-up to avoid oscillator latch up. Once powered up, the 
jumper can be positioned as desired. If no backup power is 
desired, then remove J2 (note that for board designs, it is 
desirable to ground Vback when unused). The board should 
have the daughter card installed and the serial cable 
attached to the PC prior to applying the +5V power.

Powering Down  - When powering down, the daughter card 
will operate off the backup source determined by J2 (after 
the Vcc voltage discharges from the Vcc supply capacitors). 
If the user wishes to totally power down the RTC device 
once Vcc is removed, then either the daughter card is 
removed from the motherboard or J2 is removed. Keep in 
mind there is a decoupling capacitor on the daughter card 
(0.1µF) which must discharge fully before the RTC device 
stops operating. This discharge time can be up to 1 second 
when using a Vcc of 5V. Note that when powered down, the 
RTC software cannot monitor the RTC board. If there is valid 
communication with the RTC software, then Vtrip of the RTC 
device on the daughter card is lower than that of the battery 
or super cap, which will reduce backup time.

Using the RTC Software

1. Initial setup (assuming initial power up of the RTC 
Motherboard/Daughter card)

1.1. Install PC software
1.1.1. Insert the CD ROM into your PC.
1.1.2. From the Windows Explorer, open the CD 

ROM contents. Use the Edit > Copy to Folder 
command to copy the software to the desired 
folder. It is also possible to place the program 
on the PC desktop and can be executed 
directly from there.

1.2. After opening the RTC program, you will be viewing 
the RTC Data Analysis Screen. The RTC device 
requires an initial write to the clock/calendar registers 
to begin keeping time.

1.3. Open the “Set RTC time and date” window as in 
Section 2.5 of the Software Guide. The quickest way 
to initialize is to use the “Set date and time from PC 
clock” button, although the time and date can be 
manually entered using the calendar and time 
windows. Also choose the time format, either 12 or 
24 hour. When complete, click on “Done”, bringing 
you back to the RTC time and date window.

1.4. Next, click on the “Poll RTC” button. The PC Time, 
RTC Time, and RTC Deviation windows should 
constantly update with their respective information. 
This is the normal mode for RTC 
operation/monitoring. If the RTC Time fails to update 
or is not set correctly, use the following 
troubleshooting steps.
1.4.1. RTC Time stuck at 12:00:00 and not 

advancing. The proper time was not initially 
written to the RTC registers. Go back to the 
“Set RTC Time and Date” window and set the 
time again. Also, be sure to check the PC 
serial cable hookup and Daughter card 
connections, as well as the +5Vpower 
connection to insure these are correct.

1.4.2. RTC accepted the time setting to the initial 
PC time, but not advancing. This indicates the 
serial port is working, but the RTC is not 
keeping time. The RTC oscillator has most 
likely failed to start, usually due to the 
daughter card being installed while a battery 
was in its socket. The best remedy is to 
remove the battery (or the jumper, J2) and 
cycle +5V power (wait until the power LED, 
LED1 goes out before switching power on), 
then replace the battery. 

1.5. As the program polls the RTC and updates time, 
there will be a difference between the RTC time and 
the PC time due to finite PC communications delays. 
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This should be a constant +1 or -1 second difference, 
and the window will alternately display between zero 
and 1 second error.

1.6. As the RTC or the PC clock drifts, the RTC time 
window will change color. If the RTC time is faster 
than PC time, the window will turn blue, first light blue 
then dark blue as the error increases. If the RTC time 
is slower than PC time, the window will turn red, first 
light red then dark red as the error increases.

1.7. The Polling can be turned off by clicking on the 
polling button again. The RTC device will still be 
keeping time, and if polled again in the future will 
display the current time.

2. Modifying RTC Registers

2.1. Open the RTC Register screen using the shortcut 
key in the menu bar. (section 2.9.3 of the software 
guide.) The RTC Registers are available using the 
pull-down menu on the left. Using these registers, 
the functions of the RTC device can be enabled, 
modified, or monitored, including
• Watchdog timer interval (X1227, X1228)
• Frequency output (X1226, X1228)
• Alarm settings
• Analog Trimming Registers (ATR)
• Digital Trimming Registers (DTR)

2.2. The clock/calendar registers are available also, but 
are more easily modified by using the clock/calendar 
window.

2.3. Once the correct register is located, the byte is 
displayed in the horizontal window along with its hex 
value. Changes to the individual bits can be made by 
clicking on a location. A zero is indicated with a white 
background, and a one is indicated by yellow 
background. Once the value of the byte is set, the 
byte is written to non-volatile memory by clicking on 
“Write”. A register value can be read by clicking on 
“Read”.

3. Using the RTC Deviation/Temperature Recorder (refer 
to Software Section 2.6)

3.1. The program is able to record continuous time 
measurements of the RTC deviation from PC Clock 
and the board temperature. Timeframes of from a 
few minutes to many days are possible.   From the 
RTC Data Analysis screen, first select the deviation 
range from the lower right set of pull-down windows. 
The Temperature Range and Time Base should also 
be set as desired from their pull-down windows.

3.2. Set the RTC time from the PC time as described 
above (section 1.2). This will insure the PC time is 
close to the RTC time to begin recording.

3.3. To begin recording, select “Start” from the “Record 
Data” pull-down menu (or from the menu bar). Data 
will be recorded periodically until the end of the 
timeframe selected, or until the Stop function is 
selected.

3.4. The status of the recorder is shown in the windows at 
the bottom of the RTC Data Analysis screen. These 
windows will continually update with information on 
the data recording (see 2.7.8 through 2.7.13 of the 
software guide).

3.5. Recorded data can be saved to a file, as well as 
imported from a data file (see 2.7.14 and 2.7.15 of 
the software guide).

3.6. Note that for long recordings of deviation, it is 
advisable to use a PC program that automatically 
updates the PC time, such as that available from 
AboutTime (http://www.arachnoid.com/abouttime/) or 
NIST 
(http://www.boulder.nist.gov/timefreq/service/its.htm)

3.7. Compensation for crystal frequency variation over 
temperature is accomplished using the temperature 
compensation window. See section 4 of the software 
guide for more information.

Hardware and Software Detailed 
Descriptions
Intersil Real Time Clock (RTC) Evaluation Board

1. Intersil RTC Evaluation Board – General Description

The Evaluation Board consists of the motherboard and 
daughter card. The motherboard contains all the main 
support functions for the RTC device, including:

• Microcontroller for communicating with the PC 
and the RTC using serial interfaces

• RS-232 interface IC for translating the PC serial 
port interface to the CMOS microcontroller.

• Temperature sensor for monitoring the ambient 
temperature

• Regulator to produce 3.3V from the 5V board 
supply

• Connectors for the serial port interface and the 
daughter card.

• A 0.22µF super capacitor and a 3V lithium battery 
for backup power

• Jumpers for selecting the backup battery or super 
capacitor, and also for selecting the Vcc voltage 
of 5V or 3.3V.

The daughter card contains just the Intersil RTC device, 
the crystal, and a decoupling capacitor and pull-up 
resistor for the open drain output.

2. Evaluation Board – Functional description (see 
diagram, Figure 1 and schematic, Figure 3)

2.1. Power Supply. The board requires a single power 
supply of 5V and ground. This supply should be 
regulated to 5V ±5%, and capable of at least 100mA. 
There is an on-board regulator, which produces 3.3V, 
which is available to the Intersil RTC chip as well as 
the serial interface pull-up resistors. The Intersil RTC 
device supply is selectable via a 3.3V/5V jumper. 
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The power/ground are connected via screw terminals 
on the board (see Figure 1).

2.2. Backup Supply. There are two sources of backup 
supply (Vback) available. A 0.22µF super capacitor 
is on the board. It will provide enough backup power 
for the typical RTC chip to last for 3 to 5 days at room 
temperature when Vcc is set to 5V. There is also a 
CR2032 battery included in a socket to allow 
removal/replacement without soldering. This battery 
will last from 6-10 years in normal backup operation. 
The (Vback) supply is selectable via a jumper as 
shown in Figure 1. The jumper may be removed 
altogether and an alternative source for Vback can 
be attached to the board via the exposed header. 
The center pin of the header goes to the Vback 
supply (See J2, Figure 2).

2.3. Microcontroller. The microcontroller used is the 
PIC16C63. It has a dedicated I/O port, which 
connects, to the serial interface from the RS-232 
device. There is another dedicated I/O port for the 2-
wire serial interface to the Intersil RTC device and 
the temperature sensor. The power for the 
microcontroller comes from the 5V Vcc input, so the 
microcontroller will always be powered from 5V. Note 
that the RB0 to RB4 I/O pins for the microcontroller 
are available at the daughter card connector, J3. This 
is to facilitate any extra functionality should a user 
choose to write special code for a particular 
application. The device is in a socket to allow 
removal/replacement for development activity and 
software upgrades with newly programmed devices.

2.4. Temperature Sensor. There is an LM76 temperature 
sensor on the board, which measures ambient 

temperature, digitizes it and provides it to the 
microcontroller when prompted. Since this 
temperature sensor is not physically on the RTC 
daughter card, the temperature reported may be 
slightly different from the RTC/crystal temperature in 
a thermally changing environment. When performing 
temperature testing keep in mind that the 
motherboard and daughter card, although 
connected, should have time to settle to the same 
temperature for best results.

2.5. Daughter card Connector (J3). This connector 
provides power and interface signals to the daughter 
card containing the Intersil RTC device. Specifically, 
power (3.3V or 5V), ground, the SCL and SDA serial 
interface signals, and the Vback supply voltage are 
available at this connector. This configuration allows 
these signals to be used to control the Intersil device 
on an external board by connecting the serial 
interface and ground, available at the connector. 
Also available are the RB0 to RB4 I/O signals from 
the microcontroller (see Section 2.3).

2.6. Serial Port Connector (P2). This connector is a 
standard DB-9 connector which goes to the serial 
port of a PC using a serial port cable. 

2.7. LED’s. There are 3 surface mounted LED’s on the 
board for various functions.   LED2 and LED3 
monitor the TX and RX functions of the serial port. 
They should be observed to insure that 
communication is taking place with the serial port. 
LED1 monitors the power supply and will light when 
the +5V power is applied.

FIGURE 1. RTC EVALUATION BOARD MOTHERBOARD

JUMPERS FOR SELECTING
•  Vcc = 3.3V/5V

•  Vback= BATTERY/SUPERCAP

TEMP SENSOR

POWER SUPPLY
TERMINALS

LITHIUM
BATTERY

SUPERCAPACITOR

CONNECTOR TO
RTC DAUGHTERCARD  

MICROCONTROLLER SERIAL PORT
 CONNECTOR
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3. Daughter card – functional description (see 
schematic, Figure 2)

3.1. The Daughter card contains the Intersil RTC device; 
crystal, decoupling capacitor and a 10kΩ pull-up 
resistor for the open drain output. 

3.2. Open Drain output. The open drain output of the 
X1226 is the PHZ/IRQ- signal, and for the X1227 it is 
the RESET- signal. There is test point available to 
monitor that signal, and the pull-up resistor has a 
jumper (J2) to disconnect the pull-up and also enable 
hooking up a different value externally.

3.3. Crystal. A standard 32.768kHz tuning-fork through-
hole mounted cylindrical crystal is supplied on the 
Daughter card. There are also pads provided for 
standard surface mount crystals. The through-hole 
crystal must be removed before the surface mount 
crystal is installed.

3.4. Measurements. The only signal that is recommended 
to measure on the Daughter card is the open-drain 
output. It is possible to probe the X2 oscillator output 
with a scope probe, but this is not recommended as it 
will either slow the oscillator down or possibly stop it 
due to introduction of a transient. If it is absolutely 
necessary to monitor the oscillator output, use a low-
capacitance probe (<2pF) or an active probe and 
note that the absolute frequency monitored will be 
higher than that without the probe. This can be 
verified by monitoring the RTC time in the software 
window (see RTC software manual).

P1
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4
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6
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Note:
X1226  Pin 3: PHZ/-IRQ
X1226  Pin 3: -RESET

X1
R1
10k
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4 5
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8X1

X2
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Vss SDA
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FIGURE 2. RTC DAUGHTER CARD SCHEMATIC (SHOWING THE X1226/27 RTC DEVICE)

X1227
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Intersil RTC Evaluation Board Software 
Users Guide
Software Guide
The following sections guide you through the functions of the 
software and show the screen icons and menus used to 
perform the tasks.

1. Opening Screen: Intersil RTC Data Analysis Screen:

FIGURE 4. INTERSIL RTC DATA ANALYSIS SCREEN

1.1. The Intersil RTC Data Analysis opening screen 
displays the following windows and pull-down 
menus.
• PC Time: Time of the PC clock 
• RTC Time: Time of the RTC under test when 

polling
• RTC Date: Date in the RTC registers
• RTC Deviation: Deviation of the RTC under test 

to the PC clock
• Temperature: Temperature of the RTC evaluation 

main board
• ATR Register: Analog Trimming Register (ATR) 

setting
• Poll RTC: Button to start polling and to stop 

polling the RTC under test. Note that the 
watchdog functions, if enabled, will not time out 
while polling is enabled. Note: The following 
windows and pull-down menus are used when 
recording and are discussed in the recording 
section: Section 2.7

• RTC Deviation History
• Temperature History
• Deviation Range
• Temperature Range
• Time Base
• Status
• Next Update

• Elapsed time
• Time (Current time)
• Deviation
• Temperature (current temperature)

1.2. Toolbar: The Intersil RTC Analysis screen has five 
pull-down menus in the tool bar.
• File 
• Setup 
• Record Data 
• Analysis 
• Program

1.3. Shortcut Bar: The Intersil RTC Analysis screen has 
11 buttons in the shortcut bar.
• These buttons are used for features that appear 

in the pull-down menus and will be referred to 
under the pull-down menu descriptions.

2. File Pull-Down Menu: 

FIGURE 5. FILE PULL-DOWN MENU SCREEN

2.1. The File pull-down menu has the following four 
selections:
2.1.1. Open Data File:Open a previously saved data 

file. (See the section on recording: Section 
2.7.)

2.1.2. Save Data File:Save current data file. (See 
the section on recording: Section 2.7.)

2.1.3. Print Print current screen.
2.1.4. Exit:Exit the program.

NOTE: The first 4 buttons in the shortcut bar are shortcuts to each of 
these selections.

2.2. Setup Pull-Down Menu

FIGURE 6. SETUP PULL-DOWN MENU SCREEN
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2.2.1. The Setup pull-down menu has the following 
four selections:
• Serial Port
• Temperature
• Set RTC Date and Time
• Poll RTC on Startup

NOTE: The clock button in the shortcut bar is a shortcut for the Set 
RTC Date and Time screen.

2.3. Serial Port Selection

FIGURE 7. SERIAL PORT SELECTION SCREEN

2.3.1. Com1 or Com2 may be selected for the serial 
communication port.

2.4. Temperature Offset Adjustment

FIGURE 8. TEMPERATURE OFFSET ADJUSTMENT SCREEN

2.4.1. A temperature offset from +20°C to -20°C 
may be applied to the temperature for both 
the current temperature reading and when 
recording temperature.

2.5. Set RTC Date and Time. It is a good idea to set the 
PC time and date using an accurate source. A handy 
way to do this if your PC is Internet connected is with 
a program such as AboutTime 
(http://www.arachnoid.com/abouttime/) which will 
automatically update your PC time periodically, 
essentially making it a reference clock.

FIGURE 9. RTC DATE AND TIME SCREEN

2.5.1. Set Date and Time from PC Clock button. 
Clicking on the Set Date and Time from PC 
Clock button will write the time and date that 
is in the PC to the registers of the RTC under 
test.

2.5.2. Set Date and Time button: Clicking on the Set 
Date and Time button will write the time 
shown in the time window and the date 
shown on the calendar to the registers of the 
RTC under test.

2.5.3. Get Date and Time button: Clicking on the 
Get Date and Time button will read the date 
and time stored in the RTC under test 
registers to the calendar and the time 
windows.

2.5.4. Format: 12 Hour, 24 Hour radio button. 12 
Hour or 24 Hour time format can be selected 
by clicking on the radio button for the desired 
format. Changing the format also writes to the 
MIL bit of the HR register of the RTC under 
test.

2.5.5. Calendar: The Month can be changed by 
using the forward and back arrows above the 
calendar. The day is selected by clicking on 
the desired day.

NOTE: Polling and Recording must be stopped in order to set a date 
and time other than the PC date and time.
7 AN1138.0

http://www.arachnoid.com/abouttime/ 


Application Note 1138
2.6. Poll RTC on Startup:
2.6.1. Polling on startup can be selected by clicking 

on Poll RTC on Startup selection on Startup 
pull down menu. Note: the watchdog function 
cannot be analyzed while polling since 
constant serial bus activity will not allow it to 
time out.

2.7. Record Data: The RTC test software is able to record 
time data for both RTC deviation from PC clock and 
for temperature. There is a pull-down menu for these 
functions and windows to display the graphical 
result. The Record Data pull-down menu has the 
following three selections:

FIGURE 10. RECORD DATA PULL-DOWN SCREEN

2.7.1. Start: Start the data recorder.
2.7.2. Stop: Stop the data recorder.
2.7.3. Clear: Clear the data currently displayed in 

the RTC Deviation History chart window and 
in the Temperature History chart window.

NOTE: The 5th, 6th and 7th buttons in the shortcut bar are shortcuts 
to Start, Stop, and Clear selections of the Record Data pull-down 
menu.

2.7.4. RTC Deviation History Window: This window 
is a chart of the RTC Deviation History when 
recording, or for a data file that is loaded. 
Note that the chart begins writing right to left, 
and the first reading is to the right, and the 
last reading is to the left on the chart.

2.7.5. Temperature History Window: This window is 
a chart of the temperature history when 
recording, or for a data file that is loaded. 
Again, the first reading is to the right, and the 
last reading is to the left on the chart. 

FIGURE 11. DEV. RANGE PULL-DOWN MENU SCREEN

2.7.6. The Deviation Range pull-down menu is used 
to control the y-axis of the RTC Deviation 
History Chart window. The y-axis can range 
from 1 second to 200 seconds. When set to a 
range value, the axis will automatically be set 
to plus half and minus half that value (i.e. 1 
second will show as +1/2 second to –1/2 
second.)

FIGURE 12. TEMP. RANGE PULL-DOWN MENU SCREEN

2.7.7. The Temperature Range pull-down menu is 
used to change the y-axis range for the 
Temperature History chart window. The y-axis 
can range from 10°C to 150°C.

FIGURE 13. STATUS, NEXT UPDATE, ELAPSED TIME, TIME, 
DEVIATION AND TEMP WINDOWS

2.7.8. Status: The Status window indicates whether 
the Data Recorder is running or is stopped.

2.7.9. Next Update: The Next Update window 
indicates when the next update will occur to 
the Deviation History chart as well as the 
Temperature History chart.

2.7.10. Elapsed: Shows the time elapsed since 
starting the recorder.

2.7.11. Time: By placing the cursor in the RTC 
Deviation Chart window or the Temperature 
History Chart window, the time of the cursor 
crosshatch, or the x-axis, will be displayed in 
the Time window.

2.7.12. Deviation: By placing the cursor in the RTC 
Deviation Chart window, the Deviation at the 
cursor crosshatch, or y-axis, will be displayed 
in the Deviation window.
8 AN1138.0
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2.7.13. Temp: By placing the cursor in the 
Temperature History Chart window, the 
temperature at the cursor crosshatch, or y-
axis, will be displayed in the Temp. Window.

2.7.14. Data previously recorded can be loaded to 
the RTC Deviation History Chart and the 
Temperature History chart by using the Open 
Data File selection in the File pull-down 
menu.

2.7.15. Using the Save Data File in the File pull-down 
menu in the tool bar can save the RTC 
Deviation History chart, as well as the 
Temperature History Chart.

2.8. Analysis Pull-Down Menu

FIGURE 14. INTERSIL RTC STATISTIC PULL DOWN MENU 
SCREEN

FIGURE 15. INTERSIL RTC STATISTICS SCREEN

The RTC Statistics screen shows RTC deviations from the 
PC clock as well as PPM Error for the recorded data shown 
in the RTC Deviation History Screen. It will also display the 
Minimum, Maximum and Range for the Temperature History 
chart. This can be for the data that is currently being 
recorded, or for a data file that has been loaded.

NOTE: If the Watchdog Timer is active when using I2C serial 
communication, the write must be completed during the time out 
period of the Watchdog timer or the high time.

2.9. Program pull-down menu:

FIGURE 16. PROGRAM PULL-DOWN MENU SCREEN

The Program pull-down menu has the following two 
selections

• RTC Registers/EEPROM

• Temperature Compensation

NOTE: The 10th button in the shortcut bar is a shortcut to the RTC 
Register/EEPROM selection. The thermometer is a shortcut to the 
Temperature Compensation selection.

2.9.1. Intersil RTC Register /EEPROM Access

FIGURE 17. INTERSIL RTC REGISTER/EEPROM SCREEN

2.9.2. The RTC Register /EEPROM Access screen 
allows reading and writing to all of the 
Clock/Control registers as well as the 
EEPROM array.

2.9.3. RTC Register Pull Down Menu. This menu 
allows access to the Clock/Control registers. 
The desired register is selected in the pull-
down window and each bit is displayed 
across the top of the window. The current 
contents can be read by clicking the read 
button. Changes can be made by setting the 
bits individually and writing to the register with 
the write button. You may also use the 
multiple write option. Enter the number of 
9 AN1138.0
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writes desired by entering the number into the 
Times to Write window.

FIGURE 18. INTERSIL RTC REGISTER PULL DOWN MENU 
SCREEN

NOTE: If the Watchdog Timer is active when using I2C serial 
communication, the write must be completed during the time out 
period of the Watchdog timer, or the high time.

3. RTC EEPROM Access Window

3.1. The RTC EEPROM Access window displays the 
contents of the memory buffer the contents of the 
memory buffer may be edited in this window.

FIGURE 19. RTC EEPROM SIZE SCREEN

3.2. The EEPROM Size pull-down menu changes the 
size of the EEPROM array that is addressed. The 
size should agree with the size of the EEPROM array 
of the RTC under test.

3.3. The Disk File Load button will fill the buffer with a 
data file in hex format. The Disk File Save Button will 
save the buffer to a desired file.

3.4. Data may be read from the EEPROM array to the 
buffer by using the RTC EEPROM Read button.

3.5. The data displayed in the data window can be edited 
directly by clicking on the desired location and 
editing. The entire contents of the data window can 
then be written to the EEPROM array by using the 
RTC EEPROM Write button.

4. Intersil RTC Temperature Compensation.

4.1. Intersil RTCs have on-chip oscillator compensation. 
The six analog trimming bits (ATR5 to ATR0) are 
used for adjusting the on-chip loading capacitors. 

The loading capacitors are used to adjust the 
frequency of the crystal. The on-chip capacitance 
allows for oscillator compensation from +116ppm to 
–37ppm by changing the on-chip capacitor from 
5.00pF to 19.75pF.

4.2. The temperature compensation window (see Figure 
20) is opened from the RTC Data Analyzer screen by 
selecting the Program pull-down menu, and then 
selecting Temperature Compensation. In order for 
temperature compensation to be active, the 
“Temperature Compensation Enabled” button must 
be selected in the lower right corner of the window.

A Practical Example of Temperature 
Compensation
There are six slide bars each for a different temperature 
range as indicated on the top of each slide bar. The slide 
bars allow adjusting the on-chip capacitance for the 6 
different temperature ranges. This is done by writing to the 
ATR register. The window just below the slide bar indicates 
the on-chip capacitance. The window below that indicates 
the expected PPM change (calculated based on load 
capacitance change from 12.5pF). The next window down 
indicates the ATR register setting required for the on-chip 
capacitance and the PPM setting.

The microcontroller temperature sensor located on the 
Evaluation Board allows active temperature monitoring and 
compensation. As the temperature of the Evaluation Board 
changes from one range to the next range, the new ATR 
register setting is written to the RTC under test.

FIGURE 20. INTERSIL RTC TEMPERATURE COMPENSATION 
SCREEN

Using a typical 32.768kHz crystal such as that used on the 
evaluation platform, compensation values can be calculated 
using the error equation for the crystal:

PPM Error = k(T-T0)2 where k = -0.040ppm/°C, and T0 is the 
“turnover temperature” for the crystal, typically 25°C (note 
both k and T0 have manufacturing tolerances) 

Use the center temperature for each of the six ranges as 
follows:
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0-10°C (5) = -16.0ppm (use +17ppm compensation)

10-20°C (15) = -3.5ppm (use +4ppm)

20-30°C (25) = 0ppm 

30-40°C (35) = -3.5ppm (use +4ppm)

40-50°C (45) = -16ppm (use +17ppm)

50-60°C (55) = -36ppm (use +35ppm)

The recorder must be running or the program set to polling 
mode, in addition to selecting the “Temperature 
Compensation Enabled” button in order for RTC 
Temperature Compensation to work. See section 2.7 for 
recording data. Also, see Intersil AN154 for details on the 
ATR registers and crystal compensation. 

Appendix
Calculations for Intersil RTC Data Analyzer Software

Basic Calculations

Time Base
All time is converted from hours, minutes and seconds to a 
single value for calculations. This value represents the total 
number of seconds in a 24-hour (1 day) time period. This 
value will range from 0 at 00:00:00 to 86,399 at 23:59:59.

The Time Base value is calculated as follows:

TimeBase=(Hours*3600)+(Minutes*60)+Seconds;

RTC Deviation from PC Time
This value is of primary interest for this project. In order to 
measure the accuracy of any given RTC we must have an 
accurate time source to compare with. Using a readily 
available utility such as AboutTime, the PC’s clock can be 
calibrated to within about ±100ms of the correct time. 

To find the deviation of an RTC’s time from the PC’s 
calibrated time we subtract the RTC’s time from the PC’s 
time.

RTC deviation from PC’s time is calculated as follows:

RTC_PCTimeDeviation =RTC_TimeBase–PC_TimeBase;

Improving Measurement Accuracy
The Basic Calculations are our building blocks but there is a 
problem. The RTC only provide the time to the nearest 
second therefore the Basic Calculations are only accurate to 
1 second. We need to do better than that!

It was observed that the RTC’s time will bounce 1 second 
ahead or behind the PC’s time creating a duty cycle for lack 
of a better term. If the RTC’s time is 500ms ahead of the 
nearest PC time second, the RTC time will exhibit a 50% 
duty cycle. If the RTC’s time is 750ms ahead of the nearest 
PC time second, the RTC time will exhibit a 75% duty cycle 
and so on. 
 

                  +1s  
     +500ms RTC DEVIATION FROM PC 

CLOCK 

0s 

             

          3s 
     RTC           
                  2s    

       1s 
     0s  

     3s 
     PC CLOCK 
   2s 

  1s 
 0s 
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This effect allows us to use averaging to produce very 
accurate measurements. 2 samples a second over a 144 
second sample period (288 samples) appear to yield an 
error of only ±0.05s. Of coarse, the longer the sample 
period, the better the results.

Recording RTC Data
What we’ve done so far is nice but it doesn’t tell us much 
unless we can observe the results over time. We have 
implemented a strip chart type display, which graphically 
presents the data collected over a preselected time period. 

FIGURE 21. 12 HOUR RTC SAMPLE WITH +0.236S DEVIATION 
FROM PC CLOCK 

Each pixel on the chart’s x-axis represents 1 sample period 
of which there are 300 total. 

The selected time period determines how long each sample 
period is and how many samples within each sample period. 
There are 9 time periods to choose from.

Averaging the Data
Data is collected from the Accuracy Board Test Platform 2 
times per second for the duration of the sample period.   
Each sample is added to the previous samples during the 
current sample period. When the sample period is over, the 
sum of all samples are divided by the total number of 
samples yielding the averaged result. By averaging the data 
in blocks (sample periods), a floating average scheme is 
created that provides smooth plots and also responds 
quickly to sudden changes. 

The averaged data is calculated as follows:

Do this when a new sample is acquired:

// New RTC Sample

RTC_PCTimeDeviationSum = 
RTC_PCTimeDeviationSum + RTC_PCTimeDeviation;

Do this when Sample Period is done:

// Average RTC data

RTC_PCTimeDeviationAverage =
RTC_PCTimeDeviationSum/NumberOfSamples;

Then plot this data on the strip chart.

Sample 
Period 1

Sample 
Period 2

Sample 
Period 3

… Sample 
Period 

298

Sample 
Period 

299

Sample 
Period 

300

Time Period

TIME PERIOD
SAMPLE 
PERIOD

NUMBER OF 
SAMPLES 

PRE SAMPLE 
PERIOD

NUMBER OF 
SAMPLES 
PER TIME 
PERIOD

1 hour 12s 24 7,200

3 hours 36s 72 21,600

6 hours 72s 144 43,200

12 hours 144s 288 86,400

1 day 288s 576 172,800

3 days 864s 1,728 518,400

7 days 2,016s 4,032 1,209,600

14 days 4,032s 8,640 2,592,000

30 days 8,640s 17,280 5,184,000
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All Intersil U.S. products are manufactured, assembled and tested utilizing ISO9000 quality systems.
Intersil Corporation’s quality certifications can be viewed at www.intersil.com/design/quality

Intersil products are sold by description only. Intersil Corporation reserves the right to make changes in circuit design, software and/or specifications at any time without
notice. Accordingly, the reader is cautioned to verify that data sheets are current before placing orders. Information furnished by Intersil is believed to be accurate and
reliable. However, no responsibility is assumed by Intersil or its subsidiaries for its use; nor for any infringements of patents or other rights of third parties which may result
from its use. No license is granted by implication or otherwise under any patent or patent rights of Intersil or its subsidiaries.

For information regarding Intersil Corporation and its products, see www.intersil.com

 Appendix 2
Intersil Evaluation Board Bill of Materials
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